
Scottish Qualifications Authority   1 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

 
 
 
 
 
 
 
 
An  
 
 
 
 
 
 
  
 
 
 

 
Coursework Task 
 
Intermediate 2 Information Systems 
 

Valid for session 2012/2013 only 
 

 
 
 

Publication code:  BB3417



Scottish Qualifications Authority   2 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

Coursework Task 
 
 
 
Subject: Information Systems 
 
Level: Intermediate 2 
 
 
 
 
Publication date: October 2012 
 
Publication code: BB3417 
 
 
 
Published by the Scottish Qualifications Authority 
 
The Optima Building Lowden 
58 Robertson Street 24 Wester Shawfair 
Glasgow Dalkeith 
G2 8DQ    Midlothian  
     EH22 1FD 
 
 
The assessment material and marking scheme in this Coursework pack can be used by staff in 
approved SQA centres for the purposes of assessment of candidates in accordance with the 
Course Assessment Specification.  The pack must not be released to candidates or distributed 
for other purposes.  SQA distributes these materials only to centres;  these materials are not 
distributed more widely and are not publicly available from SQA’s website on the Internet. 

 
 Scottish Qualifications Authority 2012 
 
The information in this publication may be reproduced to support SQA qualifications.  If it is to be 
used for any other purposes written permission must be obtained from the Publications Officer at the 
SQA, Glasgow. 
 
Where the publication includes materials from sources other than SQA (secondary copyright), this 
material should only be reproduced for the purposes of examination or assessment.  If it needs to be 
reproduced for any other purpose it is the centre’s responsibility to obtain the necessary copyright 
clearance.  The SQA’s NQ Assessment Development and Delivery team at Dalkeith may be able to 
direct you to the secondary sources.   
 
This publication must not be reproduced for commercial or trade purposes.  This material is for use 
by teaching staff only. 
 
 



Scottish Qualifications Authority   3 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

Contents 
 
 
Introduction Organisation and Conditions for Assessment 
 
 
Section 1  2012/2013 Coursework Task 
 
 
Section 2  Marking Information 
 
 
Appendix 1  Detailed Marking Instructions 
 
 
 
 



Scottish Qualifications Authority   4 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

 
 
 
 
 
 
 
 
 
 

Introduction 
 
 
 
 
 
 

Organisation and Conditions for Assessment 



Scottish Qualifications Authority   5 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

Organisation and Conditions for Assessment 
 
 
The assessment is designed to test each candidate’s ability to apply knowledge and understanding and 
practical skills, developed through study of the Database Systems and Using Information Units.  The 
mark out of 30 should be submitted to SQA unscaled.  This will be combined with the examination 
mark out of 70 to establish the candidate’s overall grade of award.  This mark should also be used in 
preparation of estimate grades. 
 
The notional design length for the assessment is 8 - 10 hours.  However, a candidate may be allowed 
longer than this if required.  
 
The assessment is to be undertaken under “open book” conditions, but under supervision by the 
teacher/lecturer to ensure that the work submitted is the candidate’s own work.  The teacher/lecturer 
may give the candidate hints and/or help if requested.  Any such help should be reflected in the marks 
awarded.  Once the task has been completed and marked, it should not be returned to the candidate 
for further work. 
 
These instructions are designed to be used in conjunction with the data files provided with the 
electronic distribution of the task.  These can be downloaded from the SQA secure website. 
 
The files to be downloaded should include: 

 The 2012/2013 Intermediate 2 Information Systems Coursework Task  
 Leaflet tasks 

o Speaker1 image file 
o Speaker2 image file 
o Speaker3 image file 
o CAS Logo image file 
o Jobs image file 
o Presentation 1 Fact File (text file) 
o Presentation 2 Fact File (text file) 
o Presentation 3 Fact File (text file) 
o Convention detail (text file) 

 Address Labels tasks 
o Schools (text file) 

 Spreadsheet tasks 
o Attendance details (spreadsheet file) 
o Presentation 1 (pdf style) 
o Presentation 2 (pdf style) 
o Presentation 3 (pdf style) 

 Database task 
o ConventionDB task 6-8 database 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 
prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, database files for Microsoft Access and FileMaker Pro have been provided for this 
task.  The files contain or represent a number of tables with data entered.  The appropriate file(s) 
should be made available to the candidates. 
 
Centres using alternative relational database software can use the accompanying data files, which 
contain tab-delimited data required for the tables.  The centre should set up tables as appropriate 



Scottish Qualifications Authority   6 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

within the database software and import the data provided.  The resulting database file should then be 
made available to the candidates. 
 
Candidates should be given a copy of the marking grid before starting the task so that they are aware 
of the mark distribution for each part. 
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Special Arrangements for Intermediate 2 Coursework 2012-2013 
 
Centres are asked to pay special attention to the following arrangements.  
 

 Candidates are not required to spend time entering data into a database. Instead, the data 
should be prepared beforehand and provided to candidates by the centre.  To facilitate this, 
Microsoft Access (2003 format) and Filemaker (v.7) files as well as a text (tab) delimited file 
have been provided.  Centres using other systems will be required to create the database from 
the tab separated file provided. This file can also be used if centres encounter any difficulties 
with the supplied Access or Filemaker databases.  
 

 Candidates are required to set up both tables in the database.  Candidates will be required to 
submit a printout of the Documenter (or equivalent screen shots) of both the School table 
and the Delegate table as evidence for Task 5.  After completing tasks 1-5, their work must 
be submitted and not returned.  Candidates must not be given access to the ConventionDB 
Task 6-8 database until they have submitted answers to prior tasks. 

 

 Task 5 asks candidates to print out a copy of the design of the tables.  This is to provide 
evidence that the correct field types have been used and all necessary validation checks 
implemented.  The assessor should help candidates produce this printout without penalty.  

 

 Task 5 asks candidates to print out a copy of the relationship between the tables.  The 
assessor should help candidates produce this printout without penalty. 

 

 Candidates will not use their database structures to complete Tasks 6-8.  Instead, centres 
should issue candidates with the fully populated database.  
 

 The ConventionDB Task 6-8  is a complete implementation of the system. This working 
database should be issued to candidates after Task 5 has been submitted. Candidates must 
use this working database to complete Tasks 6-8.  
  

 Additional notes follow which detail how candidate evidence is to be generated.  
 

 In FileMaker Pro, to get a printout of the design, candidates should adhere to the 
following instructions. 

(1) Select the “Define” option from the File menu and then select the “Database” 
option from the sub-menu. 

(2) Click on the Tables tab. 
(3) Highlight both tables by clicking on the name of the first table then holding 

down the shift key and clicking on the other table. 
(4) Click on the Print button. 

 

 In MS Access, to get a printout of the design, candidates should adhere to the 
following instructions.   

(1) Select the “Analyze” option from the Tools menu and then select the 
“Documenter” option from the sub-menu. 

(2) Select the table(s) required and then click Options button. 
(3) Make sure that the following options are checked/selected: 
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 Include for Table 
 Properties 
 Relationships 
 Include for Fields 
 Names, Data Types, Sizes 

and Properties 
 Include for Indexes 
 Names and Fields 
 

(4) Click on OK 
(5) The required table design is 

displayed on screen and can be 
printed. 

 
 

 Printing Relationships in FileMaker 8. 

(1) Select the “Define” option from the File menu and then select the “Database” 
option from the sub-menu. 

(2) Click on the Relationships tab then click on the Print button. 
 

 Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 

 
Alternatively, screendumps of the evidence would also be acceptable. 
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Intermediate 2 Information Systems  
Coursework Task 2012/2013 
 
 
The Careers Assistance Service (CAS) offers guidance to school pupils about education and job 
opportunities available after leaving school. 
 
Every year, CAS holds a careers convention that includes a range of presentations with guest 
speakers, information exhibits hosted by universities, colleges, employers and trade organisations as 
well as information about funding options and scholarships. 
 
CAS requires the following items to be produced: 

 a double-sided leaflet containing details about the convention 
 address labels to enable CAS to send the leaflets to each school 
 a spreadsheet to summarise the number of delegates attending each presentation 
 a database to store details of pupils attending the convention 
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What you have to do  
 

 Tasks Evidence Required 
1  You have to create a double-sided leaflet advertising the careers 

convention. 
 
The leaflet must follow these guidelines: 
 
 It must use a folded, double-sided layout similar to one 

shown below 
 

 
 
 It must contain all the information provided for the 

convention: 
o CAS logo 
o Jobs image 
o Convention details 
o Fact file for each presentation 
o Photographs of each speaker 

 
 It must use consistent headings and subheadings for each 

section of the leaflet 
 

 It must use suitable fonts, sizes and styles 
 

 It must use at least three publishing features from: 
o drop capitals 
o rotated text 
o line spacing 
o text wrap 
o borders and shading 

 
Note:  Your teacher/lecturer will provide you with the text files 
and images to be included.  You may use additional images from 
other sources if you wish. 
 

Double-sided folded 
leaflet 
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What you have to do (continued) 
 

 Tasks Evidence Required 
2  You have to create a set of address labels so that CAS can send 

leaflets to each school. 
 
Your teacher/lecturer will have provided you with the schools 
file that contains a list of delegates, school names and addresses. 
 
Add your own name and school details to the schools file. 
 
Using the schools file and the label details given below, create 
and print address labels for a mass mailing to all the schools. 
 
The label details are: 
 

Page size and orientation A4 portrait 
Label height and vertical pitch 4cm 
Label width and horizontal pitch 6cm 
Top Margin 1cm 
Side margin 1cm 
Number across 3 
Number down 7 

 
You do not need to print sticky labels.  Plain paper will suffice. 
 

Screenshot showing label 
details set up. 
 
Screenshot/printout 
showing merge fields for 
one label. 
 
Printout showing the 
address labels – one label 
for each school. 
 
You do not need to print 
sticky labels.  Plain paper 
will suffice. 
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What you have to do (continued) 
 

 Tasks Evidence Required 
3  CAS keeps track of the number of delegates from each school 

attending each presentation using a spreadsheet.  The first 
worksheet labelled Presentation1, contains details of delegates 
attending this presentation.  Similarly for worksheets 
Presentation2 and Presentation3.  The last worksheet will 
provide the convention organisers with a summary of the 
delegates attending each presentation. 
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What you have to do (continued) 
 

 Tasks Evidence Required 
3 
(contd) 

Your teacher/lecturer will have provided you with a copy of the 
Attendance details spreadsheet.   
 
You will have to use this spreadsheet to complete the summary 
worksheet to include formulae that will: 

 Calculate (Count function) the number of schools 
attending each presentation 

 Calculate (Sum function) the total number of delegates 
for each presentation 
 

The organisers would like to be able to click on cells in  
column A to open a file summarizing each of the presentations.  
Your teacher/lecturer will have provided you with 3 files, 
Presentation1, Presentation2, Presentation3. 

 
Create a formula using the hyperlink function to open the files 
summarizing each of the different presentations. 

 
Successful completion of this should give a screen like the one 
shown below. 
 

 

Two printouts of 
summary sheet – one 
showing values and one 
showing formulas. 

 
 
You must now submit Tasks 1-3 to your teacher/lecturer 
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CAS wants to store details about the schools and the student delegates in a relational database.  This 
will make it easy to retrieve information about delegates attending the convention and answer 
questions like “How many boys are attending the convention?”. 
 
CAS has designed the tables required for the database. 
 
School table 
Field Name Field Type Field Size Key Sample Data 
School ID Text 3 Primary Key S19 
School Name Text 35 No Oakenfarm Academy 
Address Text 30 No Shire Oak Road 
District Text 20 No Snead 
Town Text 20 No Oaken 
Post Code Text 8 No SY21 8JL 
 
Delegate table 
Field Name Field 

Type 
Field 
Size 

Key Validation Sample Data 

Delegate Ref Text 4 Primary Key  D101 
Forename Text 30 No  Sally 
Surname Text 30 No  Morrison 
Gender Text 6 No Restricted choice  

(only Male or Female) 
female 

Date of Birth Date  No  17/03/1995 
Presentations 
Attending 

Number  No  2 

School ID Text 3 Foreign Key Link to School table S19 
 
What you have to do (continued) 
 

 Tasks Evidence Required 
4 Using a relational database application, create a new database 

file and set up the School table and the Delegate table.  You 
should use the design shown above.  
 

 

5  Print a copy of your design for both tables in the database.  This 
should show the field types, field sizes and validation checks. 
 
 
 
 
 
(If you are unsure how to do this, your teacher/lecturer will be 
able to help you.) 

Printout/screendump of 
the School table and 
Delegate table design 
showing field types, field 
sizes and validation 
checks. 
 
Printout/screendump of 
the relationship window 
showing the link between 
the two tables. 

 
Now must now submit Tasks 4 and 5 to your teacher/lecturer. 
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Your teacher/lecturer will provide you with the database file ConventionDB task 6-8.  You must use 
this version to complete tasks 6, 7 and 8. 
 

 Tasks Evidence Required 
6  Create an attractive and user friendly form/layout to display all 

the details for one delegate.  Include all the details of their 
school. 
 
Your layout should be formatted so that the name of the delegate, 
their school name and the number of presentations they are 
attending clearly stands out. 
 
Produce a one page printout using this form/layout ensuring all 
data can be clearly seen. 
 

Printout of the 
form/layout showing all 
details. 

7  One of the special exhibits at the convention is aimed at girls 
aged 18 in the year 2013. 
 
Produce a report/layout showing the appropriate delegates.  The 
report data should be listed in alphabetical order of school, with 
delegates from each school also listed alphabetically. 
 
The printout should display only the following fields: 
Forename, Surname, School Name and Date of birth. 
 

Sorted printout of all 18 
year old girls in a 
report/layout as 
specified. 

8  The administrators of the convention need a list of all delegates 
from Whiteford Academy and Halshott Secondary schools who 
are registered for at least 2 presentations. 
 
Produce a printout of a report/layout showing the appropriate list 
of delegates.  The report data should be listed in order of the 
number of presentations they are attending, least first. 
 
The printout should display only the following fields: 
School Name, Forename, Surname, Date of birth and 
Presentations Attending. 
 

Sorted printout of all 
delegates from Whiteford 
Academy and Halshott 
Secondary schools 
attending at least 2 
presentations in a 
report/layout as 
specified. 

 
(30 marks) 

 
Collect all printouts in the order they were asked for.  Ensure your name and task number is 
printed on each report before handing to your teacher/lecturer. 
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Marking Grid 
 
Name    Date    
 

Topic 
Possible
Marks 

Marks 
Gained 

Comment 

Task 1 
Create the 
leaflet 

Leaflet as specified 3,2,1,0   

Publishing features 3,2,1,0   

 

Task 2 
Address 
Labels 

Printed Labels 4,3,2,1,0 
  

 

Task 3 Spreadsheet 

Calculate the number 
of schools for each 
presentation  

1,0 
  

Calculate the number 
of delegates for each 
presentation 

1,0 
  

Link summary page to 
presentation details 

2,1,0 
  

Print spreadsheet 
summary 

1,0 
  

 

Tasks 4–5 
Create the 
database 

Creation of tables 2,1,0   

Restricted Choice 1,0   

Link tables 1,0   

 
Task 6 Form/layout Printed layout 2,1,0   

 

Task 7 Report 

Correct Search 2,1,0   

Correct Sort 2,1,0   

Correct Report Printed 1,0   

 

Task 8 Report 

Correct Search 2,1,0   

Correct Sort 1,0   

Correct Report Printed 1,0   

 
 Overall Total  30   
 
  
 
 
 



Scottish Qualifications Authority   19 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

 
 
 
 
 
 
 
 
 

Appendix 1 
 
 
 
 
 

Detailed Marking Instructions 



Scottish Qualifications Authority   20 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

CONFIDENTIAL – not to be issued to candidates 
Detailed Marking Guidelines 
 
The following guidelines assume that all work was carried out by the candidate on their own (or with 
the assistance of open book materials).  Any assistance by the teacher/lecturer should be reflected in a 
reduction of the number of marks awarded. 
 

Task 1 
Create the 
leaflet 

Create the leaflet 3,2,1,0 Leaflet created as specified 
 Appropriate double-sided, folded layout  

(1 mark) 
 All body text and headings included and 

formatted with appropriate and consistent 
font, size, style for each  (1 mark) 

 CAS logo, jobs image and speaker images 
included (1 mark) 

 
Publishing features 3,2,1,0 Any 3 from 

 Drop capitals  
 Rotate text 
 Line spacing 
 Text wrap 
 Borders and shading 
 

 

Task 2 
Create 
address 
labels 

Own contact details 1,0  Add extra line/row of details 
Design label 1,0  Set up specialized label size 
Create label 1,0  Insert merge fields 
Print the labels 1,0  One label per school printed 
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Task 3 Spreadsheet 

Calculate number of 
schools for each 
presentation 

1,0  Correct use of COUNT function on 
summary worksheet to count number of 
schools for each presentation 

 eg =COUNT(‘Presentation 1’!B4:B23) 
Notes: 
 1 mark for correct range in COUNT 

function referring to appropriate 
presentation worksheet and correct cell 
range 

 0 marks if function used on individual 
presentation worksheet 

 Three correct COUNT formulas used on 
the summary worksheet required for  
1 mark 

Calculate number of 
delegates for each 
presentation 

1,0  Correct use of SUM function on summary 
worksheet to count number of schools for 
each presentation 

 =SUM(‘Presentation 1’!B4:B23) 
Notes: 
 1 mark for correct range in SUM function 

referring to appropriate presentation 
worksheet and correct cell range 

 0 marks if function used on individual 
presentation worksheet 

 Three correct SUM formulas used on the 
summary worksheet required for 1 mark 

Link summary page 
to presentation 

2,1,0  Candidates MUST use the hyperlink 
function.  Simply inserting a hyperlink 
would not be awarded the marks. 

 Correct use of HYPERLINK function to 
create links between each presentation file 
and the summary page 

 eg =HYPERLINK(“C:\Users\fred\Desktop\
Presentation 1.pdf”, “Presentation 2”) 

 1 mark for path/filename 
 1 mark for display text 
 Three correct HYPERLINK formulas used 

on the summary worksheet required for  
1 mark 

Print spreadsheet 
summary 

1,0  One printed version showing answers to 
formula calculations with row/column 
headings visible 
and 

 One printed version showing formulas used 
visible 

 

Task 4–5 
Create the 
database 

Creation of tables 2,1,0 Accurate creation of 
 all tables and field names and PKs 
 all field types and sizes 

Restricted choice 1,0 Gender set to restricted choice – only male, 
female values accepted 

Link tables 1,0 Tables linked without teacher/lecturer help using 
School ID 
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Task 6 Form/Layout 

Printed Layout 2,1,0  One page layout created without help.  All 
fields from both tables should be clearly 
visible.  (School ID should only appear 
once) (1 mark) 

 Appropriately designed with Forename, 
Surname, School Name and Presentations 
Attending standing out using larger size or 
different style or colour etc (1 mark) 

 

Task 7 Report 

Correct Search 2,1,0 Complex search for  
 Gender = female 
 Date of Birth 

>=1/1/1995 AND 
<=31/12/1995 

or 
 Date of birth contains *1995* 

Correct Sort 2,1,0 Complex sort both ascending (2 marks)  
 School Name ascending 
 and then Surname ascending 
Simple sort only = 1 mark 
Complex sort with 1 ascending and 1 
descending  = 1 mark 
Otherwise = 0 marks 

Report Printed 1,0 School name, Forename, Surname, Date of Birth 
fields included and clearly visible 

 

Task 8 Report 

Correct Search 2,1,0 Complex search for 
 Presentations Attending >=2 
 School Name = Halshott Secondary OR 

Whiteford Academy 
Correct Sort 1,0 Sort 

 Presentations Attending  
Ascending order 

Report Printed 1,0 School Name, Forename, Surname, Date of 
Birth and Presentations Attending fields 
included and clearly visible. 

 
 Total Marks 30  
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Sample Solutions 
 
Task 1  
Side 1 sample layout 
 

 
 
Side 2 sample layout 
 

 
 
 



Scottish Qualifications Authority   24 
Coursework Task 

Intermediate 2 Information Systems  2012/2013 

Task 2  
Screenshot showing label set up Printout/Screenshot showing merge fields  
 

         
 
Single A4 page with 21 address labels (including own contact details) 
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Task 3 

 
 
Tasks 4-5 

 or  
 
Task 6  
Example A – 2 marks 
Good consideration of design, all fields visible. 
Delegate forename and surname, school name and Presentations attending clearly stand out using 
appropriate features (size/colour/style/border etc) 

 
 
Example B – 1 mark 
No consideration of design or highlighting as specified, but all fields included are visible. 
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Task 7:  28 records 
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Task 8:  12 records 
 

 
 
 
 
 
 
 
 


